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HOUSEKEEPING

¢ Introductions . zgﬁ?
¢ Pen/pencil & paper FOLLOWING
e Distractions

— Cell phone

— Pets

— Other household members
WHAT WAS

i 1 BULLET =3
e (Questions — “Raise Hand” LEARN HOW
Q TO READ AND aoie

. FOLLOW
Breaks INSTRUCTIONS ((

. /]
¢ If we lose Internet connection s

e Course Credit

3
Agenda
e Year in Review
e Packet Update — Outpost and PackltForms
e Simulated Public Service Event - SET
e Intermod Calculator
e Training Update
e Cupertino - Infectious Disease Response Plan
e Forms Review
e Credentialing Program and COVID
4
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Year in Review

Tim Howard, KE6TIM
Revised 7-Dec-2020

2020 Objectives and Goals

e Aggressive Training and Exercise Plan
e Earn C4 Credential by Year End

e Adding WiFi connection to BBS Backbone
for cities and agencies.

e March 11 - we cancelled or postponed all
events thru mid April

e March 17 — SCCo Shelter In Place order

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved. 3
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What we did to address COVID

Cancelled or Postponed Added
Mar — Net Control 1IB Class Apr — Repeater Sprint Contest
Mar — Fundamentals Class June — Field Packet Mini Drill
Mar — Pop-Up NC Practice Oct — Sim. Public Service Event
Mar — Medical Health Exer.
Apr—NC Type Il Class Modified & Rescheduled
May — Message Passing Class May — Pop-Up Message Passing
Jun — Event Planning Class June — Pop-Up Packet Practice
Aug — RDF Mini Drill July — Field Ops Type IIA Class

Nov — Message Passing Class July — Field Ops Type IIB Class

Modified some classes for Presentation via Zoom

7
Classes Not Conducive to Remote Teaching
e Message Passing Class
— Numerous one-on-one participant interaction sending and
receiving messages between two participants
— Student interaction with instructor and other participants
that does not lend itself to remote instruction
What can you do?
Read the Message Handling Procedures document is a good
place to start. Reviewing the examples shown will make you
a better message passer.
WWW.scc-ares-races.org/training/courses/Msg_Passing/Message_Handling_Procedures_v191115.pdf
8
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Classes Not Conducive to Remote Teaching

e Event Planning Table-Top
— Close interaction between team members during the class.

— Participants are seated at a table and plan a simulated
event. They discuss requirements and plans for
equipment, staff, addressing each aspect of an event: NC,
Packet, Field Ops, Shadows, Logistics, Safety, Staging, etc.

What can you do?
Review the class Event Planning handouts

If you want to gain experience volunteer to help plan an
event at the city level, or assist an experienced planner on
one of the county events.

9
Packet
Update
Jim Oberhofer, KN6PE
Revised 7-Dec-2020
10
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Packet Exercise

11

Weekly Packet “Practice”

2020... by the numbers (through 8-Dec-2020)

Total Practice Messages sent 1394

% Correct all the time  96.6%

Ave # of Participants / Night 27

1744 3138 2844 2116

94.7% 95.5% 93.7% 93.2%

34 31 29 25.5

S

+6% +12%

12
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Weekly Packet “Practice”

e See the “Standard Packet Check-In/Out Message” App Note
under...
https://www.scc-ares-races.org/data/packet/index.html#app-notes

e See the Practice Message, Subject section under...
https://www.scc-ares-races.org/data/packet/weekly-packet-
practice.htm|#Message

13

What was new, different in 20207

14
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440 access channels added
BBS Call Signs and Frequencies

Call Sign | AX.25 ||UserAccess BBS-BBS | Location

WIXSC | WIXSC-1|145.750, 223.620, 433.570

Santa Clara Co Office Bldg (San Jose)

W2XSC | W2XSC-1|145.730, 223.560, 433.590

Crystal Peak (South County)

W3XSC | W3XSC-1|144.310, 223.540, 433.450

Palo Alto

W4XSC | WAXSC-1 || 145.690, 223.6007, 433.550 | 223.600

Frazier Peak (above Milpitas)

W5XSC | W5XSC-1 || varies varies

Training, events, backup

WEXSC || WEXSC-1 | varies varies

Testing, backup

e Recommendation

— Individuals use 2m or 440 access ( more readily available equipment)
— EOCs use 220 access (less congested)

— Download and print this listing for your Go Kit
— Check web site and bulletins for changes

15

Mutual Aid Request Form

SCC RACES

Message Numbers:
Date: 12/07/2020
ICS Position; |

Santa Clara County RACES -- Mutual Aid Request

Origin: 6PE-19217 Destination:

T Location: |

e The Mutual Aid Request form |0 e

Contact Info:

is used to request radio RACES  [se=r

Event  Incident

operators during an activation. |

¢ This form is now part of the
public packet installer 150M. ==

e Do notuse for...
— RACES Public Service Events Bogs ol

— Non-RACES jurisdiction mutual
aid requests

Travel Info

Reporting Location [Strec:

| Number

Preferred Type  Minimum Type

Oato(s): |

Timags): |

Dato(s): |

Timais: |

t Addréss, varcung, encry Instructions

Contact on Arrival  [\ase/Position and contact info

Cal Sign:

ate: ((date)} Time: {{t1me)}

Requested By Hame: | | Tite: |
Contact [E-sail, phone, frea
Approved By Name: | | Tioe: |
fory Gontact [E-sail, phone, y
Signature: Date:  12/07/2020 Tins: [bhimm |
Radio Operator Only:
Relay: Revd: =

16
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Zoom!
Packet training in pajamas

e Ran all the packet classes by zoom

e Zoom registration helped track who actually showed up (and
stayed for the entire class!)

e Completing the homework was prerequisite for class credit

e Office Hours offered a chance for troubleshooting, a 1-on-1
chat, and general Q&A

* Quizzes... checked if you were still with us

17

® polis

Polling 1: Q1

1. If anything is possible, is it possible for anything to be
impossible?

18
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Quizzes help check how we are doing

User Name

~ Question T/ Answer
='Q2. Packet Radio is good for passing: All of the above
='Q3. One city where a SCCo RACES BBS is located is: Palo Alto
=/Q5. The TNC that is used by the County and many operators KPC3+
=/Q6. We use a tactical calls in packet radio because: it keeps the station packet address the sa
=Q7. Areceived message displayed as red on the In Tray indi The message is Urgent.
=Q8. What are PackltForms? Forms-based messaging that supports sen
=Q2. Packet Radio is good for passing: All of the above
=Q3. One city where a SCCo RACES BBS is located is: Palo Alto
=Q5. The TNC that is used by the County and many operators KPC3+
=/Q6. We use a tactical calls in packet radio because: it keeps the station packet address the sa
= Q7. Areceived message displayed as red on the In Tray indi The message has not yet been read.
=/Q8. What are PackitForms? Forms-based messaging that supports sen
=Q2. Packet Radio is good for passing: All of the above
=Q3. One city where a SCCo RACES BBS is located is: Palo Alto
=Q5. The TNC that is used by the County and many operators KPC3+
='Q6. We use a tactical calls in packet radio because: it keeps the station packet address the sa
=Q7. Areceived message displayed as red on the In Tray indi The message is Urgent.
=Q8. What are PackitForms? Forms-based messaging that supports se
Q3.

One city where a SCCo RACES BBS is located is: Palo Alto

19

Outpost & PackltForms

Review

20
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What’s in the box?

® SCCo Integrated Packet Installer 150M
e Qutpost Packet Message Manager

— GUI-based interface for managing packet communications

— Makes using packet as simple as using e-mail
e PackltForms
— Next generation HTML-based forms for use with Outpost
— Headless Chrome for auto-printing support
e PacFORMS
— HTML-based forms for use with Outpost

— Since 2007, simplified forms-based data entry, reduced network
bandwidth

21
SCCo Installer vi150M
December 2020
PackltForm 3.2*
* PackltForms AutoPrinting
* Move the XSC RACES Mutual Aid Request from the private to
the public edition
* browse.cmd enhancements and updates
» Various form updates
Outpost v3.4 c015*
By the numbers These were related to
e 1 New Feature 12 - Message Handling o
e 15 Defects 9 — PackltForms AutoPrinting
e 33 Enhancements 5 — Other Addon Enhancements
19 5CCo Submitted 4 - Opscripts _
e 49 Total changes ... plus another 19 various changes
*See the release notes for details
22

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved. 11



2020 Year End Summary

What’s new with
Outpost and PackltForms

23
4. Message changes
B Outpost Packet Message Manager
Popup Menus
e New | Open | Archive | Delete | Print | SendReceive | Profie:[Guipost
* Pops up a specific menu of
common commands or controls. oty | [Fom [To (685 [locallD 54
. . . — k6plh@... meuc‘gm:!c !’.‘1155‘53 TST-A5... PL|
¢ Highlight a message and right- |_oarer | [ispn g T o
. SentMsgs i  Enbanced...
click to open the popup menu ey [| [0 o el
_I 1gt001@... tste
* Added to RN [ vk e
— Outpost message listing [_Doctes | | mpL- e et Unesd
5jc003@... te Archive
— When creating a new message X5C Notices .s'.eoﬁ... P
. tsteoc@... ftste Cep
— After receiving a message SR
Delete
NOTE! Missing your favorite R
command? Let me know. Se—caiad P gttt
24
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3. Message changes

Enhancing Readability

e Ever notice the & |A|inthe upper right

portion of the forms?

¢ These controls decrease or increase the

font size of the text areas.

e Changes are preserved and will be applied Emrrmrrr——E

the next time you run Outpost.

HINT: If you have a lot of Unread Messages ?
(those shown in BOLD), you must restart

\ el Received/Sent message form

Yward | Archive Delete | Close 4‘(:
3 New message form
j @ 1

J Pt | Bul [T

Oquost message Ilst D

T

P AT

Date/Ti “'"AL

acket Fraquencies v200905 9/5/2020 18:39

Packet Subject Line v200222 2/22/2020 05:28
ISC Tactical Calls vI91127 11/27/2019 10:56
;xn:ket Check-In/Out v190712 712/2019 2235

acket Tactical Calls v190704 7/4/2019 11:05

W

Outpost for the font resize to take affect.

25

2. New installation?

¢ On a NEW clean install, Outpost now

defaults the data directory to

C:\SCCo Packet

¢ If Qutpost is not pointing to this
data directory now AND your
installation works fine, then
there is no need to change it.

Setup - SCCo Packet (PUBLIC EDITION)

Information
Please read the following important information before continuing.

Setup - SCCo Packet (PUBLIC EDITION)

Select Destination Location
Where should SCCo Packet (PUBLIC EDITION) be installed?

Setup - SCCo Packet (PUBLIC EDITION)

Select a data location
Where should SCCo Packet data be installed?

Setup will install or update SCCo Packet data in the following folder.
To continue, dick Next. If you want to select a different data folder, dick Browse.

[C:\SCCo Packe! Browse...

B Setup - SCCo Packet (PUBLIC EDITION)

Ready to Install
Setup is now ready to begin installing SCCo Packet (PUBLIC EDITION) on your
computer.

Click Install o continue with the installation, or diick Back If you want to review or
change any settings.

Destination location:
C:\Program Files (x86)\SCCo Packet

Start Menu folder:
SCCo Packet

Additional tasks:
Additional shortcuts:
Create a desktop shortcut

Data directory location:
C:\SCCo Packet

"

<Bok Ganael

26
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1. AutoPrinting for PackltForms

e AutoPrinting of PackltForms has been an objective since the
PackltForms initiative was kicked off.

e The main requirements were:

— Message printing should occur automatically for both outgoing and
incoming messages. This will build on the capability that exists for
plain text messages.

— The user can control turning AutoPrinting on and off.
— All auto-printing occurs without user intervention.
e The Outpost v3.4 with PackltForms 3.2 releases make
AutoPrinting a reality.

27
1. AutoPrinting for PackltForms
Features
1. Automatically print messages when they are received, or sent
2. Includes plain text and PackltForm messages
3. Selectable number of copies for received and sent messages
4. Add footers to PackltForms
When should you use this
1. Need to distribute messages to different teams in the EOC or ICP
2. Keep track of who gets which copy
Who is using this now
1. SCC RACES at the County EOC
28
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Step by step process
AutoPrinting

Install the latest version of SCC Installer 150M
Run Outpost

Set up Send/Receive Settings

Set up General Print Settings

Do it!

vk wihe

29

Plan for printing copies

1. Before you do anything, make sure you know who needs to
get copies of SCCo PackltForms. For instance, suppose you
plan on distributing message copies to the following:

— Radio Room
— Planning & Intel
— Operations

e Next...

30
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Set up Outpost for AutoPrinting

2. From Outpost, -
Autoration | Receiving  Printing | Natifications | Other |
— Tools > Send/Receive Settings, ically print during the ive Session
. . b Printmessages to the HP OfficeJet 4650 series printer
Prlntlng Ta v AutoPrint
. [v Printreceived messages... |3— copies (110 9)
- CheCk AUtOPrlnt [ Print sent messages.. |1— copies (110 9)
v CheCk Print received messages and [~ Print DELIVERY and READ receipt messages
enter the number of copieS' 3 for this [¢ Print headers for plain text messages (not forms)
,
example. [# Print copy names in form footers View Copy Names

v" Check Print sent messages if you want
outgoing messages printed.

v" Check Print copy names... if you want
footers printed.

If you intend to use Copy Names, press ok | appy | canca
the [View Copy Name] button to set the
Copy Names. NOTE! Copy Names refers to

the footer text that is placed on
the bottom of the PackltForm.

31
Set up Outpost for AutoPrinting
3. From the [View Copy Name] button
- artul ressin rofiles  Printin Miscellaneous
(or Tools > General Settings) , sl Aasssnsl el et
Forms Printing
— Enter the Copy Names as you want o Uee ConyRiomest -
% Use Copy Names for manual printing
them to appear on the PackItForm Copy Names (use a separate line for each copy name)
footer; one per line. oo oo
— The order in which you enter them is ppersiond
the order they will be printed.
v |f you want to use Copy Names for v Turn on PDF Spooler (should be on)
manual printing, make sure that box is
checked.
NOTE! The PDF Spooler should always oK Apply Cancel
be on.
32
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4. With this setup, you
just received a
PackltForm ICS213
message. Within 30
seconds, you see 3
copies printed out.

Watching it happen

MESSAGE FORM

SCCo ICS Form 213 (05/29/2019)  PIF 2.1

Sender's Msg # * My Msg #
CUP-1562P 6PE-1563P

Receiver's Msg # *

Date: ' Situation Severity *
12/05/2020 Emergency
(e.g. ife threat)

Time: 24 te ciock)

Urgent
" {0.g. property threat)
1:22 Other

{all others)

ICS Position: 7
DEC

Message Handling Order °

Immediate Take action
{as soon as possible) Yes O No
Priority Reply
(less than one hour) Yos, by
= Reutine

{more than one hour)
ICS Position: *
EC

Location: ** F  Location: *
T  sCC E0C R  Cupertino EOC
O Name: O Name:
M
# U

Message Requests You To: ¢

No

For your info (o action required)

How Received

Operator Name: Jin Oberhofer

Sersent T T T ot éﬂrsmﬁ%v? T e e

Telephone Dispatch Center
\,_/_"'
9 EOC Radio FAX Courier
. Amatour Radio # Other: Packet Date: 12/65/2020 Time: 21:25
Hom
CuP-1562p Radio Room Page 10 1
CUP-1562F Planning & Intel Page 10f 1 I
cup.1562p Operations Page 10f 1 I

33
Controlling what gets printed
¢ On the Tools > Send/Receive Settings, Printing Tab, you have number of
copies to be printed.
¢ On the Tools > General Settings, Printing Tab, you set the copy names (3
in our example).
¢ Which takes precedence?
If # copies is set AND Copy Names | Then what is printed...
to... is...
1 Radio Room Radio Room
Planning & Intel
Operations
3 Radio Room Radio Room
Planning & Intel Planning & Intel
Operations Operations
4 Radio Room Radio Room
Planning & Intel Planning & Intel
Operations Operations
<blank footer>
34
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What about manual printing?

B Outpost Packet Message Manager

File | Edit Setup Tools Forms Actions Help

o E
e Same rules apply. AT i
Save All...
e To print more than one copy, o
Import
— File > Print... M:dean\dum

Copyto Folder.

— Select your Printer

Delete All Messages

— Change Number of copies ot
— Print! Gener |
® To try mUIti_COpy printing S:i:“;;::ﬂﬂ%iﬁ ssssss = Microsoft XPS Documen
without actual paper-printing, =t ettt = b
select, try... e ’
— CutePDF Writer e
— Microsoft XPS Document S
— OneNote “;‘“I
" Selection c
— Snagit 12 print driver - |
NOTE: Not all print drivers support
multiple copy printing Cancel

aRecene || Profie:

[

poc@wixsc

? oc@wixsc

|6PE
poc@wixsc.a...
boc@wixsc am
poc@wixsc
poc@wixsc
fEoC
poc@wixsc
poc@wixsc

S T

35

What’s new for 20217

e Maintenance release planned
— Adds suggested changes to PackltForms
— Fixes reported bugs; more enhancements to Outpost

* Pop-up Packet Exercise
— Date... thd

e Packet class schedule
— Packet Type lllIA  7-Aug-2021
— Packet Type llIB 2-Oct-2021
— Packet Type Il 6-Nov-2021

36
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For More Information

e Support

— See the Santa Clara County ARES/RACES web site packet page
e https://www.scc-ares-races.org/data/packet/index.html

— Join the packet discussion group

e Practice

— Send a message during the weekly packet net, either or both days
e https://www.scc-ares-races.org/data/packet/weekly-packet-practice.html

e Automated feedback to help you improve, verify you’ve got it right

— Participate as a packet operator at drills and other events

37

Simulated
Public Service Event
and ARRL SET

Andreas Ott, K6OTT
Revised 3-Dec-2019

Photo credits: Leslie Grimm KK6EKN, Loretta Keller WB6BWQ, Mark Laubach K6FJC

38
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2020: the “uneventful” year

e Zero public service events this year, even the one quarterly drill
outdoor activity needed to be called off due to heavy smoke
(extremely bad air quality in August)

¢ Almost no other qualifying events for credentials
¢ New Concept: the parade is simulated and everything was made
up. Follow scripted playbook activities for actors, to “provoke”

radio traffic that closely resembles the one from the real world
parade.

¢ Exercise built for two hours, run it twice: once you are an operator,
once you are a simulator

¢ Designed as deployment exercise with very little training
component (not strictly meant for newbies)

¢ Entirely outdoor, physically distant operators, no “touch”
community items (sharing radios)

¢ Adhere to state and county COVID-19 guidelines, stay home if you
have symptoms, wash your hands, don’t touch your face

39

Nobody saw that coming...

¢ We moved into uncharted territory by putting on an event that is
100% simulated. The Pros @SCC_OES hire a specialized and $5$
consulting firm to put on exercises like “Yellow Command”.

e Prior Art: “Drill in a binder” in Los Altos

¢ Your Planning Team: 8 core members, plus input from Jim Clark,
N6JRC and the real parade Nancy

¢ 4 weeks planning, 7 meetings, estimated 350 hrs

¢ Developed framework and placed events on the timeline, put tasks,
injects and instructions into playbooks. Procedure to automatically
generate printed sheets for each simulator from the MSEL (master
scenario events list) spreadsheet. Create roleplay instructions for
Principals. Write briefings for all positions. Go!

40
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MSEL based planning

Simulator: MunsterCar-Sim8

Time: 10:04:00

Title: car circumventing barricade at Whitney St and 1st St; driving in

olice.

rout
Props needed: cardboard car2

Details what you need to do: usecar prop driving in from float viewing area, go all the way east
o 15t St, turn right onto State St, right cn 2nd St, west on 2nd St, left on Main, hang out there

(in parade route)

What is expected to happen: checkpaint to report type of car, license plate, direction of travel

End of task: drive back out after 2 minutes, back the way you came

Unfortunately, nobody can be told what The Matrix is.

Parade documents + map

Handling “situations”, Lost
Parent & Found Child

Briefings
4 netcontrols on 3 nets,
rotate every 25 mins

Parade Principals and
Shadows

One MSEL per net

One Inject task per sheet for
simulators: at <time> do
<this> until <that>

Float drivers, pedestrians

41

Statistics - day of the event

e Reduced number of SET categories scored, only one agency,
one community served, no formal traffic

e 44 Amateur Radio Operators participated, approximately 300

volunteer hours delivered

e Of these were 15 “new” hams, licensed since 2016

e 100% of stations on emergency power!
e Current ARRL SET score 266, THANK YOU!

e |t’s just slightly more than a quarter of the points compared
to last year, but better than nothing. We don’t know yet how

the big hitters will score.

42
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After Action talking points

e We did OK on prescribing the Simulation, but it depends on
the actors pulling their weight acting them out through
roleplay

¢ Some simulation took on a life of its own

e Some simulation events need more QA, especially if they are
multi-step or multi-operator

e We exercised some real world scenarios (open mike, traffic
during netcontrol shift change)

e Forms handling has improved!

e During an activation: you MUST NOT leave home without
being checked in on the Resource Net

43

Photos: Parade Route

44
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P

hotos: Operators in position

45

Photos: Simulator Briefing

46

Copyright 2020 Santa Clara County ARES/RACES. All Rights Reserved.

12/8/2020

23



2020 Year End Summary 12/8/2020

Photos: Parade Floats at Third Street

47

Photos: Netcontrol

48
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3

Photos: Police Liaison near Safeway

49

50
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Photos: award winning masks Jeff & Kelly

51

Intermod Calculator

Andreas Ott, K6OTT
Revised 3-Dec-2019

52
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limited use.
o Still looking for feedback

against three receive frequencies

frequency
= (2f ), (2f-Fy), (2f,+F,), (2f,4F))

other nearby receivers)

* Won't affect our other receivers

isolated ham radio event

e From 2020 Antenna Fundamentals Class

e We only had one event for which we needed to calculate any potential intermodulation
distortion, and that event also used more than 3 frequencies. So, this tool was of

Intermod Calculator Spreadsheet

— The last two are typically out of band (beware of VHF/UHF)

e |saspreadsheet the correct tool, or would you rather use a Python3 script (which could
be made to handle more than three frequencies)?

e Calculation for two transmit frequencies is performed for you, results are checked

e Fortwo transmitters, the four most interesting 3™ order products are displayed and
cells use conditional formatting to display red background if too close to the third

— The first two are of most interest because they are near the two transmitters (or may land close to

* Could affect other radio services at a shared transmitter site if not filtered, but not so important for an

e Bonus: Spreadsheet also calculates 3™ harmonics (2m and 70cm bands)

53

. IntermodCalculator_v2beta ¥ & &
File Edit View Insert Format Data Tools Add-ons Help Lasteditwason September 27
o @ PO00% « $ % 0 00 128 Oefaut(aio ~ 10 « B I S A % H Evl-|a~%- co B @MY~ 3I-
Instructions:
A 8 c o € v o W f 3

i [instructions: | Put three simplex or repeater output frequencies into bold cells E4, G+ and i4 (11, 12, £3 [MHzI), then add repeater offset +/- [MHz] or zero for simplex
2 The input frequency cells F4, H4 and J4 will be calculated. Intermod calculations are done using output frequencies, checks for input and outpur in each column
3 [r1output — rt input [fzoutput  [rzinput floutput  [f3input |

Frequencies [ 145.470| 144.570| 147.500] 147.500) 442.500] 447.500
5 repeater offset [ -0.600] | 0.000] | 5.000] |
6
7 Products category 3rd order Intermod
o interesting Hout+f2oul-fout -149.830 149,830 4.660) 5.260] z.m' 2330 -282.670] -207.670
o [interesting “fout+2out+fdout 444,630 444,630 299,660 300.260) 297.330) 297.330) 2330 2,670
10 interesting Houl-f2outsf3out 440.170 430,170 295.000 295.600) 292.670| 292670| 4.ﬁ| 7.330
1 very interesting | 2fout-f2out 142.840 142.840 -2.330) -1.730) 4.# 4660 -299.660 -304.660
"2 very interesting | 2Mout-f3out 152,160 152160 6990 7.590 4,660 4.660, -290.340 -295.340
2 very interesting | 2f2out-Hout 149.830 149.830 4.660 5.260 2.330] 2.330] -292.670| 297.670
4 very interesting | 2f2out-f3out 147.500 147,500 2330 2.930 n.g 0.000| -295.000 -300.000
15 interesting 23out-Hout 739,830 739.830 594,660 505.260) 592.330| 592330 297.330) 292330
i interesting [2130ut-120ut 737.500 737.500 502.330| 502.930 590.000( 590.000( 205,000/ 200,000
17 3rd harmenics _|3fout 43551 435510 290340 200.940) 288.010| 288,010 -6.9%0| -11.990
i@ 3rd harmenics _|af2out 4425 442500 207330 207.930) 295.000| 295,000 0,000, -5.000
19 3rdharmonics | 3f3out 13215 1327500 1182.330 1182.930 1180.000| 1180.000| 885.000] 880,000
20 outliers 2f1out+f2out 437.840 437.840 292,670 293.270| 290.340 290.340| -4.660)| -9.660
21 outliers 2f1out+f3out 732,840 732840 587,670 588.270 585340, 585340 290.340 285.340
22 outliers 2f20ut+fiout 440.170 440.170 295.000 295.600 292,670 292.670| -2.330| =7.330
s  outlers 2Az20ut+30ut 737.500 737,500 592330 592.930) 590.000| 590.000| 295000 290,000
2 outliers 2out+iout 1030170 1030.170 885,000 885.600) 862.670) 862670 587.670) 562670
2 outliers 23out+2out 737.500 737.500 592,330 592.930 590.000[ 590.000] 295.000] 200,000
2%
27 red=closer than 0.015 MHz
£l green=further than 0.025 MHz
30 Version History:
3 vibeta 2020-08-19 for antenna fundamentals and erossband repeating class.
32 vabeta 2020-08-27 clarify using output frequencies for intermod calculation, compare to inputs and outputs in columns E through J

+ = 3Frequencies ~ & Frequencies -
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Training Plans for 2021

Judy Halchin, KKGBEWQ
Revised 5-Dec-2019

55

Scheduled classes for 2021

e Introduction to Emergency Communications (Zoom)

e Fundamentals of Emergency Communications (Zoom)

e Field Operations IlIA, 111B/II (Outdoor)

¢ Net Control IlIA, 1B, Il (Zoom)

e Shadowing (Zoom)

e Packet Operations IlIA, I1IB, II (Zoom)

e Cross-Band Repeating / Antenna Fundamentals (Zoom)
56
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Zoom classes

* No need to travel

* Presentations work well

* Practice sessions work better for some people

e Many fewer questions asked during Zoom classes

e Very little interaction among the participants in Zoom

When it’s allowed and safe, we will go back to in-person classes,
but we’ll try to keep some of the benefits of Zoom classes.

57
Cupertino
Infectious Disease Response Plan
Jim Oberhofer, KN6PE
Revised 1-Dec-2019
58
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Situation
What does this mean to us?

The COVID-19 pandemic is occurring, and will be with us for a while.
The loss of life and associated economic and social trauma has been significant.

Given the speed of its onset and expected duration, it is prudent to have a plan
in place that guides our emergency field response.

The complication of dealing with compound emergencies must be factored into
any response plans to ensure we not only can meet the assigned mission, but
also maintain the health and safety of everyone involved.

Consider:

e earthquake ...
* wildland fire threat... L ... during a pandemic
e 200 year flood ...

*The pandemic element of the response is what we addressed.

60
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Where to find it

Infectious Disease Response Plan

[ https://www.cupertinoares.org

Welcome! Docs & References
Home
Introduction | SOP | Field References | Net Control Scripts | Mesh Networking
About us Updated: 10 August 2020
Operations
Frequencies Introduction
Training

T Ensuring a repeatable process is critical to ensure a successful activation

Exercises & Events field deployment. Skills are maintained by practice and drills, and ensuring

Docs & References that the response process is understood, consistent, and repeatable. This
section describes the various documents that support this objective.

Resources

Projects Back

Cupertino Citizen "

Corps Standard Operating Procedures

County RACES Name Description, Content

City of Cupertino Infectious Disease Response  This document is §
Plan (.docx), Sep 2020

mental guidance for

Infectious Disease Response Plan
Cupertino Citizen Corps

2 September 2020, vrsion 10

fical response during an infactious. e
Member Log in * pandemic event. Revisions will be mad| citfzen*corps
rew guidance becomes available
61
What’s in it
IDR Plan Contents
1 Introduction 3
1.1 Distribution 3
12 Goal 3
13 Objective 3
14 Scope of impacted operations 3
1.5 Critical Mitigating Elements. 4
16 Minimizing the Risks 4
1.7 Assessing Risks 5
2 Procedures 6
21 General Field Deployment Operations [
2.2 Changes to ARK Level 3 Operations 7
2.3 Changes to ARK Level 2 Operations 7
24 Changes to ARK Level 1 Operations 8
2.5 Changes 10 Fire Station OPETATIONS .....coeieesene s sies e s enseassenssemsssas s snssemsssasssnnssssssnses snsesns 9
2.6 Comm 469 Operations 10
2.7 Medical Reserve Corps Operation: 10
3 RolesandR ibilitie 11
3.1 Safety Officer, Assistant Safety Officer Checklist 11
3.2 Fixed Field Station Checklist 12
33 Individual/Mobile STation CheckliST.... .. .curemieerierrercossiesscassaeseesssmss s ens s smss e sns e sns s s 13
4 Policies 14
4.1 Vehicle Cleaning & Disinfecting Guidance’ 14
4.2 Hygiene Procedures 15
4.3 Protocol for Possible Exposure 16
5  Logistics Support 17
5.1 Additional material required at CCC facilities 17
5.2 Responder Go-Kit Requirements 17
5.3 Half page CCC Health Attestation Form .18
A, City Cleaning Supplies Document 19
B. CDC Guidance 21
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OES Goal... only one

Cupertino OES gave us only one goal for our Infectious Disease Response Plan, that is,
no matter what we do:

* Protect the health and safety of the public and Cupertino

Citizen Corps responders

63

Plan Objectives

1. Protect CCC responders and the community with whom we

interact

a. Protect their health and safety.
b. Maximize resources to maintain day-to-day emergency operations.
c.  Minimize the virus spread and reduce the impact on CCC and public health.

2. Maintain the continuity of response operations
a. Continue day-to-day readiness and response operations to the maximum extent
possible throughout all stages of the pandemic.
3. Execute the CCC pandemic response

a. Ensure all CCC teams and facilities can fulfill their response responsibilities during a
pandemic.

b. Communicate and coordinate pandemic preparedness and response to all City staff and

other CCC members.
c.  Support the efforts of the City in mitigating the consequences of a pandemic.
Do not become part of the problem.

64
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Leveraging from similar risks

https://www.nrc.gov/about-nrc/radiation/protects-you/protection-principles.html

+  REPORT
RSAFETY GONGERN

| 1
NUCLEAR RADIOACTIVE NUCLEAR PUBLIC MEETINGS & ABOUT
REACTORS MATERIALS WASTE SECURITY INVOLVEMENT NRC

FRINT i

¢k HOW HRC PROTECTS YOU Home > About NRC > Radiation Protection > How NRC Protects You > Minimize Your Exposure

Minimize Your Exposure

Regulation of Radioactive Naterials
Although exposure to ionizing radiation carries a risk, it is impossible to completely avoid exposure.

Nucle Medi .
st Radiation has always been present in the environment and in our bodies. We can, however, avoid
Radiation Monitoring at Nuclear Power Time, Distance, and shielding

Plants N N

Time, distance, and shielding measures minimize your exposure to radiation in much the same way as
they would to protect you against overexposure to the sun (as illustrated in the figure below)

* Time: For people who are exposed to radiation in addition to natural background radiation,
limiting or minimizing the exposure time reduces the dose from the radiation source.

» Distance: Just as the heat from a fire is less intense the further away you are, so the intensity
and dose of radiation decreases dramatically as you increase your distance from the source.

» Shielding: Barriers of lead, concrete, or water provide protection from penetrating radiation such
as gamma rays and neutrons. This is why certain radioactive materials are stored under water or
in concrete or lead-lined rooms, and why dentists place a lead blanket on patients receiving
x-rays of their teeth. Similarly, special plastic shields stop beta particles, and air stops alpha
particles. Therefore, inserting the proper shield between you and a radiation source will greatly
reduce or eliminate the dose you receive.

65

Distance
Minimizing pandemic risk

Limiting close face-to-face contact with others SOCIAL DISTANCING

is the best way to reduce the spread of ‘ " o o .
eep one wavelen apart al 1z
COVID-19... keeping space between yourself P hlos

and other people outside of your home.

CDC recommends:

e Stay at least 6 feet (about 2 arms’ length)
from other people.

e Limit close contact with others outside your
household in indoor and outdoor spaces.

146MHz
2.0m < 6.7ft

CCC Action Plan:
1. Adopt and implement social distancing requirements to the fullest extent possible.

66
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Time (duration)
Minimizing pandemic risk

J J
P
. . . . g g e (J
Most discussions on duration of exposure are aimed at Health S S N g
Care Professionals (HCP), especially those working in the %‘v\j/\’”
vicinity of aerosol treatments. The time (or duration) aspect By AN

of a contact comes into play when physical distancing
requirements cannot be maintained.

Environmental considerations must be factored in when
thinking about limiting or minimizing any possible exposure time.

*  Spaces with poor air circulation (rooms with little or no ventilation) may result in a build-up
of airborne viral matter that increases the likelihood of an infection.

*  Conversely, spaces with good air circulation (spaces with open doors and windows, being
outside) reduce the viral load by dispersing it over it a wider area.

CCC Action Plan:

1. Do not engage in activities similar to those of HCP (be prepared to render First Aid if safe; do
so with proper PPE).

2. Maximize the use of outdoor spaces whenever possible to maintain good air circulation.

67

Shielding / PPE

Minimizing pandemic risk

Cloth face coverings are most likely to reduce

the spread of COVID-19 when they are

widely used by people in public settings. WH EN AL L
P ELSE FAILS 4

NOTE: You wearing a mask protects others
from you, not you from others.

(g)
ham RAD' g
WORK:

CDC recommends:

* People wear cloth face coverings in
public settings when around people outside
of their household, especially when other
social distancing measures are difficult to
maintain

CCC Action Plan:

1. Cloth face covering is required when a CCC responder is near anyone else.

NOTE: Starting June 18 2020, per state order, Californians must wear face coverings in
common and public indoor spaces and outdoors when distancing is not possible.

68
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Applying the Swiss Cheese Model

(&
ANY SAFEGUBRD Y o~ &
: > &
HAS INHERENT & ¥ é‘%“ &
FLAWS OR HOLES 55\ o o ol

PROBLEMS OCLUR. WHEN MULTIPLE "ROLES ' LINE. UP

(@sketchplanations/J. Reason)
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Assessing Risks

Low risk

. Physical Distancing. Keep at least

6 ft (2 meters) from others in
public.

. Reduced group size in enclosed

spaces

. Outdoor gatherings
4. Sufficient ventilation
. Face masks

vR W e

High Risk
Close-up, in-person interaction
Crowded events
Poorly ventilated spaces

. People talking loudly, singing
. Prolonged exposure (15 minutes

of unprotected exposure with
someone less than 6 ft)

70
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Scope of the Plan

General Field Assignments
ARK Level 3 Operations
ARK Level 2 Operations
ARK Level 1 Operations
Fire Stations Operations
Comm 469 Operations

N o Uk wNeR

Roles and Responsibilities

71

1. General Field Deployment Operations

Highlights — CARES

Deployment activities involve operating a radio in the field to report

observations or passing messages by radio on behalf of someone else; applies

to Infrastructure Safety Assessment, Ember Watches, and Alt911 operations.

* A Safety Officer will be designated, either dedicated or in conjunction with other
duties.

* Exercise social distancing between responders and the public at all times, except as
strictly necessary to carry out a task associated with the response mission

* CCC members should recruit other household members as their Buddy

* SS checks resource list for pre-identified members interested in single-person
(solo) assignments

* Use two vehicles if two non-household responders travel to the same location

* If you are not comfortable with your surroundings or assignment, let your
supervisor know

72
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4. ARK Level 1 Operations

General Layout

Layout and people flow = —

ARK/Trailer f

DSW Area

73

6. Comm 469 Operations

e Highlights —CARES
* All General Field Deployment Operations changes apply.

* Only one individual will occupy the Comm 469 cab at a time. Supporting
staff follows in separate vehicles.

* When deployed, all vehicle operating compartment doors and roof vent
will be open for increased air circulation.

* Operations are split between inside and outside.
* Radio Room Operator (P3) and Shift Supervisor (P4)
* Resource Net (P1) and SCC County voice net/Packet (P2)

74
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First Look Exercise, 14 Nov 2020

Cupertino ARES/RACES

7. Roles & Responsibilities

Infectious Disease Response Checklists

This checklistis
two or more reg

Before the Event

Afterthe Evem

3.1 Safety Officer, Assistant Safety Officer Checklist
All field deployment locations will have a designated Safety Officer named. This may be a dedicated or
shared position depending on the number of people at a specific location.

Checklist — Safety Officer, Pandemic Health Component

3.2 Fixed Field Station Checklist

A fixed field station is a radio station set up at either a pre-defined facility or ad-hoc location where
communications station infrastructure is put in place (coverage, tables, chairs, power, etc.). This
checklist covers Fixed Field Stations.

1. Kn
2. Up| Checklist
Te This checklist is rel
3. Unl responders are co-
During the Event| Before the Event
4 M 1. Respq
up During the Event
5. Cg 2 d
6 Prg—— 7 Form
7.ve—— r;ut
8. Pe
9. Enl —— 4. S!:IIO
10. Sig b
11. Pr c'
12. ll:e dv'
— u ..
° 5. Publi
13. Pel
— a.
(>

3.3 Individual/Mobile Station Checklist
An Individual/mobile station is where the operator uses an HT (Hand Talkie) or automobile-based
mobile radio to pass radio traffic. This checklist covers Individual Field Stations.

Checklist

This checklist is relevant for all CARES responders during an infectious disease event where two or more
responders are co-located at a fixed field station to perform a specific event task.

Before the Event
1. Responders confirm Go-Kit readiness including enhanced PPE items.

During the Event
2. Cloth face masks are mandatory whenever you are in close proximity of another person.
3. Maintain physical distance from any person that you encounter.

After the Event
4. Oncompletion of your assignment, submit all infectious disease-related paperwork to the
City EOC (include these documents as part of Demob to be submitted to the Planning
Section).
S. Performs a full wipe down of your equipment. Replenish your stock any protection

I
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Go Kit Additions

¢ The following additional CCC Responder Go-Kit items are required:
1. Cloth face mask
2. Eye protection
3. Nitrile gloves, at least 2 pair
¢ The following additional CCC Responder Go-Kit items are
recommended:
1. Hand sanitizer
2. Sanitizing wipes
3. Face shield

77
Forms Review
Why the paperwork is important
Andreas Ott, K6OTT
Revised 7-Dec-2020
78
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Broken record:
Why logs are important

* The paperwork we get from you is part of us
exercising supervision over you while you
are deployed. And we need proof of that in
case we need to submit a DSW insurance
incident report form.

* By keeping good documentation we can
show that you did the “right thing ™”, also
important as a witness statement of events

79

From the lonesome event
this year

* Forms handling quality has improved compared to
last year!

* Training works! So please attend our classes.

* |CS-214 (FieldOps 3A and NetControl 3A Classes)
and video training

* |CS-309 (NetControl 3A and FieldOps 3B Classes)
and video training

* This year’s event had no ICS-213 form messages
(multiple classes / Monthly Practice Sessions)

e But still .....

80
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Problems 1: Did these operators
attend the same event | did?

ICS-214: only 9 lines are filled in (vs. 38
lines, or 21 lines on mine), no ICS-309

OK to be less verbose when it’s boring,
but just attending an event is 8 lines

Lost child/parent? crowd counts? H&W
Time stamps out of order

ICS-214 last entry at 11:30, operator
left event at 14:30 according to 1CS-211

81

Problems 2: Unit Name and Unit
Leader on ICS-214

e Unit Name: Your assigned tactical call
or the name of the net you are the
netcontrol for, might change

e Unit Leader: Your name and call sign
(fill in right away), won’t change

1. Incident Name and Activation Number |2. Operational Period (Date/Time)
gsNzIL_I;gg Mockingbird Heights Mummy Race 10/31/18 11/1/18
ARES/RACEs | RIP-18-13T From: 2000 To: 04:00

4. Unit Leader (Name, Call Sign, ICS Position)
Herman Munster, W6XRL4

3. Unit Name / Tactical Call / Designators
Tactical Net Control

82
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Problems 3: Netcontrol ICS-309
* This is the main log of all happenings
* FROM and TO columns! See training
* Message column: keywords

* Use English, and we need to be able to
decode your abbreviations

 Shift Changes (wax on — wax off, don’t
forget to breathe)

83

Problems 4: Radio Net Name and
Radio Operator Name ICS-309

* It should be obvious, but just in case

* And if you forgot your name, check
your Drivers License or FCC license

COMM LO 1. Incident Name and Activation Number 2. Operational Period (Date/Time)
ICS 309-SCCo Mockingbird Heights Mummy Race 10/31/13 11/113
ARES/RACES RIP-13-13T From: 2000 To: 0400
4. Radio Operator (Name, Call Sign)
Wolf Man, W6WOOF

3. Radio Net Name (for NCOs) or Position/Tactical Call
Resource Net

84
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Credential Program
Challenges During COVID

Tim Howard, KE6TIM
Revised 6-Dec-2020

85

Events are Required to Gain
Experience

e Experience in varied activities is an
important part of earning a Credential

* No Public Service Events
* Few Drills/Exercise

86
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2020
Limited Number of Evaluations

e Pop-Up Packet — P3 and P2 Evals
e Quarterly Drill = N3, P3

e Quarterly Drill = F3 Evals cancelled due
to poor air quality (fires)

87

2021 Planned Eval Opportunities

e Pop-Up Packet — P3 and P2 Evals

e Quarterly Drills — N3, P3, F3, maybe
some Type 2 depending on evaluator
availability.

* We will remain open to other
opportunities that meet Credential
requirements without sacrificing
program quality.

88
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What about 2 year requirement

* The Credential program requires that
requirements must be completed
within a 2-year period.

* That time frame will be extended.

e When that time frame is determined it
will be published.

 But, if an event/activity is offered try
and take advantage, don’t wait.

89

Challenges

e COVID is still with us and probably will
affect the number and types of
activities for some time.

* We may plan events and later have to
cancel them if situations change.

* Bringing the resources (staff, location,
scenario, etc.) together takes time and
effort.

* Be patient and flexible.

90
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DSW Stickers

* New stickers for your County DSW card
will be sent to the ECs for distribution.

o If ...

* you are currently a County DSW

* your contact data in the activity database
has been updated or verified within the
past 12 months.

91

Update/Verify Contact Info

My Profile
My Contact Info

My Completion Certificates
My Credentials

My MAC-Qualifying Events
Cities/Agencies I Support
Change My Call Sign
Change My Password

My Contact Information

-Personal Information

Call Sign* [W6XRL4
First Name* [Herman
Last Name* Munster
Address 1* [1313 Mockingbird Ln
Address 2 —

City* Mockingbird Hgts
State* XX
Zip* 99999-0123

Emergency Contact Information
Emergency contact* | Lily Munster
Contact number*  |999-555-1234

Thomas Bros. Map Information
Enter the appropriate information for the above address

Page (3 digits) * |
Column (A-Z) * ﬁ
Row (1-9) * [
* denotes required field

You last reviewed this information on: 01/07/2011
1 have reviewed the information on this page [
Save Changes |

- Contact Information:
Home Phone# | 999-555-1475
Work Phone# | 999-555-5693
Cell Phone# |999-555-4321
Pager
e-mail #1* |[W6XRL4@arrl.net
e-mail #2 hmunster1815@gmail.com

* denotes required field
# at least one number is required

- AlertSCC Information
What's this?

County of Santa Clara )

Phone #1 : ’W
Phone #2 : %
Phone #3: [
e-mail #1 : ’m
e-mail #2: %
SMS #1: [999-555-4321

se AlertSCC, Phone #1 cannot be blank.

Note: to u
If it is blank, the other information is ignored.

Clear changes and start again
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Q&A

All Staff

93

Thank You!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

If you have questions or feedback about this or other training
activities, you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training
This is a moderated group.

See you at a training class or exercise next year!
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